CONTENTS

• Field of Application
• Installation on Windows
• Installation on Mac
• Activation
• License Comparison
• How It Works
  ◦ Workspace
  ◦ Using the Program
  ◦ Classic Style
  ◦ Artistic Style
  ◦ Timeline
  ◦ Toolbar
  ◦ Background Effects
  ◦ Adding a Frame
  ◦ Text and Watermark
  ◦ Drawing on a Canvas
  ◦ Presets
  ◦ Preferences
  ◦ Batch Processing
  ◦ Print Image
• Examples
  ◦ Shiny Apple: An Artist's Touch
  ◦ Self-Expression: Sketch in a Minute
  ◦ Convert a Photo to a Color Sketch
  ◦ Pencil Sketch: Let's Draw a Tulip
• AKVIS Programs
AKVIS Sketch converts photos into pencil sketches and even creates watercolor paintings.

Now you do not need to handle a pencil to feel like an artist. All you need to create your original work of art is good taste and AKVIS Sketch!

We propose an efficient method that lets you create realistic color drawings and B&W sketches, imitate the technique of graphite and color pencil, and even generate the charcoal, pastel, and watercolor effects.

In contrast to standard filters that offer an approximate sketch, AKVIS Sketch comes very close to the hand-drawn works of a human artist. Getting a similar result with the standard tools would require expertise in image editing and extensive manipulation with layers, masks, brushes and applying filters. AKVIS Sketch lets you create an awesome pencil drawing from any photograph with a mouse click!

The software offers two photo to sketch conversion styles: Classic and Artistic, which help to create a wide variety of pencil drawings. Each style has its own benefits. You may play with the settings and enjoy the results!
The software has a neat interface with a few sliders. At first you can process the picture with the default settings and then touch up the image by adding color, or trying different techniques - from pencil to charcoal or watercolor. You can make the hatching denser or finer and change the pitch angle of strokes.
The extremely helpful **Timeline** feature allows you to get variations of your drawing without adjusting the settings. Watch the process and choose between the snapshots.

The program offers a list of ready-to-use presets which make it easier to work with the software and save you time. You can create your own presets with your favorite combinations of the photo to drawing parameters.
You can make a pencil portrait as a gift for your relatives and friends, print your sketch on a T-Shirt, decorate a room with a watercolor drawing or a poster. Designers use the program to quickly bring images to one style for a website or an advertisement booklet. Authors create illustrations for their books with this software.

Both professionals and home users will be delighted with the ease and effectiveness of the program and excited by the neat result of the photo-to-sketch conversion. Using AKVIS Sketch is a lot of fun!

*On the whole it's a wonderful tool for those who have always wanted to draw but didn't know how.*
Using the software you can also add some unique background effects to your picture! Create a combination of a sketch and a photo, mixing drawings with real life; imitate motion or add a "time machine effect" by swirling the background. Put an accent to certain parts of the image by blurring the rest of it in an artistic way.

The Batch Processing support lets you automatically convert a series of images. You can make comics or cartoons from your home videos in this way.

You can personalize your work of art by inserting an inscription, a signature, a greeting, a logo or a watermark; add a rough texture surface to your image, as if it had been drawn on canvas, corrugated paper, brick wall, etc.
The software is available as an independent standalone program and as a plugin to a photo editor. The plugin version is compatible with AliveColors, Adobe Photoshop, Corel PaintShop Pro, etc. Check the compatibility.

The functionality of the software depends on the license type. Consult the comparison table.

During the trial period you can try all options and choose the license you like.
INSTALLATION

Follow the instructions to install AKVIS Sketch in Windows.

- Start the setup exe file.
- Select your language and press the OK button to launch the installation process.
- To continue the installation process you have to read and accept the License Agreement.

Activate the check box "I accept the terms in the license agreement", and press Next.

To install the Plugin you should select your photo editor(s) from the list.

Hint:
If your photo editor is not in the list, activate the component Custom Plugins Directory and choose the folder where you keep all plugins and filters, for example, C:\My Plugins. In this case you should set this folder as the plugins folder in the settings of your photo editor.

Or you can copy the 8bf file into the Plug-ins folder of your image editor.

To install the Standalone version, make sure that the check-box Standalone is activated.

To create a shortcut for the program on desktop, activate the component Shortcut on Desktop.

Press the button Next.
• Press the button **Install**.

• The installation is in progress.
• The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates and events.

• Press Finish to exit Setup.

After installation of the standalone version of Sketch, you will see a new line in the Start menu: AKVIS - Sketch and a shortcut on desktop, if during installation the component Shortcut on Desktop was enabled.
After installation of the Sketch plugin you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop: Filter -> AKVIS -> Sketch. Please use this command to launch the plugin in the editor.
INSTALLATION

Follow the instructions to install **AKVIS Sketch** in a Mac computer:

- Open the virtual disk **dmg**:
  - **akvis-sketch-app.dmg** to install the **Standalone** version
  - **akvis-sketch-plugin.dmg** to install the **Plugin** to your image editor (Photoshop or Photoshop Elements).

- Read the **License Agreement** and press **Agree**, if you agree with the conditions.

- **Finder** will open with **AKVIS Sketch** application or **AKVIS Sketch PlugIn** inside.

- To install the **Standalone** version just drag the **AKVIS Sketch** application into the folder **Applications** (or any other place you like).

To install the **Plugin** drag the entire **AKVIS Sketch PlugIn** folder into the **Plug-Ins** folder of your graphic editor.

For example:

  if you use **Photoshop CC 2018**, copy the plugin into **Applications/Adobe Photoshop CC 2018/Plug-Ins**;
if you use **Photoshop CC 2017**, copy it into **Applications/Adobe Photoshop CC 2017/Plug-Ins**;

if you use **Photoshop CC 2015.5**, copy it into **Library/Application Support/Adobe/Plug-Ins/CC**;

if you use **Photoshop CC 2015**, copy it into **Applications/Adobe Photoshop CC 2015/Plug-ins**;

if you use **Photoshop CS6**, copy it into **Applications/Adobe Photoshop CS6/Plug-ins**.

After installation of the plugin, you will see a new item in the Filter menu of your photo editor. In Photoshop select in menu: **Filter -> AKVIS -> Sketch**.

Run the standalone app by double-clicking on its icon in Finder.
HOW TO ACTIVATE AKVIS SOFTWARE

**Attention!** During the activation process your computer must be connected to Internet.
If it is not possible, we offer you an alternative way (see below for Offline Activation).

Download **AKVIS Sketch** and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the number of days left in your trial period.

You can also open the **About the Program** window by pressing the button  in the program’s Control Panel.

![AKVIS Sketch](image)

Evaluation period has expired.
Unregistered Version

Click on **TRY IT** to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types: **Home** (Plugin or Standalone), **Home Deluxe**, or **Business**. Your choice of license will affect which features will be available in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the **TRY IT** button is disabled.

Click on **BUY NOW** to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.
Click on **ACTIVATE** to start the activation process.

Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

**Direct connection:**

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press **ACTIVATE**.

Your registration is completed!

**Request by e-mail:**

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

**NOTE:** You can also use this method for **Offline Activation**:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet, for example, with a USB stick. Send us this information to: activate@akvis.com.

**Please do not send the screenshot!** Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (**Sketch.lic**) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the **AKVIS** folder in Users’ Shared (Public) Documents:

- **Windows Vista/7/8/10:**
Your registration is completed!

When the program is registered, **BUY NOW** turns to **UPGRADE** that lets you improve your license (for example, change **Home** to **Home Deluxe** or **Business**).
AKVIS Sketch is photo to sketch conversion software. The functionality of the program depends on the license type. During the test period you can try all options and choose the license you like.

<table>
<thead>
<tr>
<th>License Comparison:</th>
<th>Home (Plugin)</th>
<th>Home (Standalone)</th>
<th>Home Deluxe (Plugin+Standalone)</th>
<th>Business (Plugin+Standalone)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non-commercial use</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>commercial use</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td><strong>Edition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standalone</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Features</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photo to Sketch Conversion:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Classic Style</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Artistic Style</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Black &amp; White Sketch</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Color Sketch</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Cross-hatching</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Tools:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stroke Direction Tool</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Selection (Effect Area Tools)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Post-Processing Tools</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Crop</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Additional Features:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timeline</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Background Effects</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Text and Watermark</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Drawing on a Canvas</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Frames</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Presets</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Import/Export Files:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.sketch (Presets)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>*.direction (Guiding lines)</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Batch Processing</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Feature</td>
<td>Windows XP, Vista, 7, 8, 8.1, 10</td>
<td>Mac OS X 10.7-10.11, macOS 10.12-10.13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------</td>
<td>--------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Share</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Large Format Print</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXIF, IPTC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Space</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RGB</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMYK</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lab</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grayscale</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 / 16 bits</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32 bits</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Format</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIFF</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JPEG</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BMP</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PNG</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RAW</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNG</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSD</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows XP, Vista, 7, 8, 8.1, 10</td>
<td>✔ 32-bit/64-bit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.7-10.11, macOS 10.12-10.13</td>
<td>✔ 32-bit/64-bit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10-days trial</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price</td>
<td>$72 $72 $89 $154</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**AKVIS Sketch** can work independently as a **standalone program** as well as a **plug-in** to a photo editor.

- **Standalone** is an independent program; you can open it by clicking on the program's icon.

  To launch the standalone version, run the program directly:
  
  On a Windows computer - select it from the **Start** menu or use the program's shortcut.
  
  On a Mac computer - launch the app from the **Application** folder.

- **Plugin** is an add-on for a **photo editor**, for example for Photoshop.

  To call the plugin, select it from filters of your image editing program.

The workspace will be arranged according to the editing mode chosen in the **Control Panel: Express** or **Advanced**.

In **Express** mode, the program's interface is extremely simplified. It has the minimal set of parameters needed for a user to quickly obtain a satisfactory result.

![Workspace of AKVIS Sketch (Express)](image)

In **Advanced** mode, the full functionality of the program is available: all parameters, under the relevant tabs **Sketch, Background, Decoration**, as well as the toolbar.

Note: All features and parameters work in **Express** mode. Some are hidden and use default values or those of a chosen preset.
The left part of the program's window is taken by the **Image Window** with two tabs - **Before** and **After**. The **Before** tab shows the original image, the **After** tab shows the resulting pencil sketch. To switch between the tabs and compare the original and the resulting images, just left-click on any point of the image.

In the upper part of the program's window you can see the **Control Panel** and the following controls:

- The button ![home](image) opens the home page of **AKVIS Sketch**.
- The button ![open](image) (only in the standalone version) opens an image for processing. The hot-keys are `Ctrl+O` on Windows, `⌘+O` on Mac.
- Right mouse click on this button displays the list of recent files. You can change the number of recent documents in the program's preferences.
- The button ![save](image) (only in the standalone version) saves image to the disk. The hot-keys are `Ctrl+S` on Windows, `⌘+S` on Mac.
- The button ![print](image) (only in the standalone version) prints the image. The hot-keys are `Ctrl+P` on Windows, `⌘+P` on Mac.
- The button ![share](image) lets posting pictures from the program to the social networks: Twitter, Flickr, Tumblr, Google+.
- The button ![batch](image) (only in the standalone version) opens the **Batch Processing** dialog to

![Workspace of AKVIS Sketch (Advanced)](image)
automatically process a series of images.
The button imports a list of presets (from the .sketch file).

The button exports presets (user settings for the image processing). You can save any number of presets to a separate file with the ending .sketch.
The button shows/hides the guiding lines and the effect area outlines drawn with the tools.
The button loads saved guiding lines (from the .direction file).
The button saves the guiding lines to a file with the .direction extension.
The button cancels the last operation made with lines (guiding lines and background outlines).
It is possible to cancel several operations in a row. The hotkeys are Ctrl+Z, on Windows, ⌘+Z on Mac.
The button returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys are Ctrl+Y on Windows, ⌘+Y on Mac.
The button starts conversion of the original image into a pencil sketch with the current parameter settings. The result is shown in the After tab.
The button (only in the plugin version) applies the result to the image and closes the plugin.
The button calls information about the program.
The button calls the Help files. The hot-key is F1.
The button calls the Preferences dialog box for changing the program's options.
The button opens a window showing the latest news about Sketch.

In the Advanced mode, to the left of the main window there is a Toolbar. Different tools appear depending on the active tab, Before or After.

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

Additionally, you can move the image in the Image Window with the scroll bars or by holding down the space bar, then holding down the left mouse button while moving the mouse. The mouse's scroll wheel can move the image up and down, and holding Ctrl (⌘ in Mac) – while using the scroll wheel will move the image left and right. Holding Alt (Option in Mac) will scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider or the buttons and to scale the image in the Image Window. When you click on the button or move the slider to the right, the image scale increases. When you click on the button or
move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field and pressing the button Enter (Return in Mac). Frequently used scale coefficients can be found in a drop-down menu.

You can use hot-keys to change the image scale + and Ctrl+ (⌘+ in Mac) to increase the image scale and - and Ctrl- (⌘- in Mac) to reduce the scale.

Under the Navigator there is the Settings Panel where you can choose the photo-to-sketch conversion Style (Classic/Artistic); and adjust the parameters.

The Settings Panel has three tabs of settings: Sketch, Background, andDecoration.

- On the Sketch tab you can adjust the settings for photo-to-sketch conversion of the selected style.
- On the Background tab you can define the area of the picture that should be blurred, or the areas that should remain in their original state.
- On the Decoration tab you can add text to an image, adjust the canvas surface, and apply a frame.

In the Presets field you can save the current settings as a preset to use them in the future. The current settings can be saved, edited, deleted. When you launch the program, it uses the settings of the last used preset.

**Attention!** The presets save only information about the settings in the Sketch and Decoration tabs (not Background!).

Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them with the cursor. You can choose where the hints will be shown or hide them in the program's Preferences.
**HOW IT WORKS**

**AKVIS Sketch** converts photos into pencil sketches, the software allows creating realistic color and black and white drawings. The software can be used independently as a standalone program or as a plugin filter in a photo editor.

In order to turn a photo into a pencil sketch follow the instructions:

**Step 1.** Open an image.

- If you work with the standalone edition:

  The dialog box **Select File to Open** appears if you double-click on the empty workspace of the program or if you click on the button on the **Control Panel**. You can also drag the required image into the workspace of the program.

  The Standalone edition of **AKVIS Sketch** supports **RAW**, **JPEG**, **PNG**, **BMP**, and **TIFF** file formats.

- If you work with the plugin:

  Open an image in your photo editor by calling the command **File -> Open** or using the key combination **Ctrl + O** (or **⌘ + O** on Mac).

  Call the **AKVIS Sketch** plugin select the menu item **Filter -> AKVIS -> Sketch** in **Adobe Photoshop** and **Photoshop Elements**; in **Corel PaintShop Photo Pro** select the menu item **Effects -> Plugins -> AKVIS -> Sketch**; in **Corel Photo-Paint** select the menu item **Effects -> AKVIS -> Sketch**.

**Step 2.** The first time the program is opened it will be in **Express** mode, with a simplified interface and a minimal set of sliders, which help to quickly obtain a satisfactory result.

![](AKVIS Sketch Workspace, Express Mode)
Experienced users who are familiar with the capabilities of **AKVIS Sketch** can switch to **Advanced** mode. Switch to this mode by clicking the **Advanced** button: the interface’s appearance will change, granting access to the full functionality of the program.

**Note:** All parameters work in **Express** mode as well; some are hidden and the program uses values of a chosen preset.

Once the program is open, part of the image will be automatically converted to a pencil drawing. The result will be shown in the quick preview area in the **Before** tab.

To convert the whole image, click on or on the **After** tab. After processing it is possible to switch between tabs by pressing the left mouse button on any point of the image.
Step 3. Select the photo-to-sketch conversion style - **Classic** or **Artistic**; and adjust its parameters.

**Classic** style lets you create color and B&W drawings with well-defined contour lines. A characteristic feature of this style is its accuracy: the image looks as if it was primarily created by contour lines with the addition of hatching. Though this mode is versatile and good for many purposes, it is the most suitable for technical illustration, architectural images, and other pictures where you would like to attain good detail.

**Artistic** style is designed to create expressive drawings that look like the handmade work of a real artist. In this style, it is easy to create both a quick sketch and a carefully drawn and shaded pencil drawing. The main advantage of this style is the ability to play with hatching and to vary the number of shadings and shadows to get natural tonal transitions. This style requires a good photograph. The best results can be achieved if the original photo was taken in the right light and has good contrast.
**Step 4.** Click on to convert the photo into a pencil drawing with the new settings.

**Note:** You can observe the processing in real-time. It’s possible to stop photo-to-sketch rendering and save the semi-processed drawing as a result. To interrupt the process, use the Stop button right to the progress bar.

**Step 5.** Optionally, in the Classic Style, you can use a special tool that lets you change the direction of the applied pencil strokes. This Stroke Direction tool gives you full control over how hatching is drawn on an image. Using this technique you can achieve a truly realistic drawing with patterns and textures going in the right direction.

**Note:** This feature is only available for the Home Deluxe and Business licenses.

**Step 6.** You can also adjust the settings on the Background tab and use Decoration options: Canvas, Frame, and Text. Click on the button to start processing the image.
Step 7. It is possible to save the settings you like as a Preset and use them in the future. A preset contains the settings of the Sketch and Decoration tabs.

To process an image with the settings of a certain preset, you select it from the drop-down menu and press the button.

Step 8. The Timeline feature allows you to get variations of your drawing without adjusting the settings. If you like some semi-processed image more than your final result, click on it to choose. The shot will be shown in the After tab.

If you want to get back to your final result, click on the last shot in the Timeline list.

Note: This feature is only available for the Home Deluxe and Business licenses.

You can set the number of the shots in the Preferences dialog box.

Step 9. You can edit the result and put the finishing touches to your drawing with the post-processing tools: Pencil, Eraser, and History Brush in the After tab.

Note: These tools are only available for the Home Deluxe and Business licenses.

Hint: Use the post-processing tools at the final step! If you run the processing again, the changes made with the tools will be lost.
Step 10. In the standalone version, you can cut off unwanted areas of the result and improve its composition with the Crop tool. If you use the plugin, you can do this in your image editor.

Step 11. Share your sketch by clicking on . This button opens the list of the services where you can publish the image: Twitter, Flickr, Tumblr, Google+.

In the standalone version, you can also print your result using .

Step 12. Save the processed image.
- If you work with the standalone program:

  Click on the button to open the Save s dialog box. Enter a name for the file, choose the format (TIFF, BMP, JPEG or PNG) and indicate the target folder.

- If you work with the plugin:

  Press the button to apply the result and close the plugin window. The AKVIS Sketch plugin will close and the picture will appear in the workspace of the photo editor.

  Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format and indicate the target folder.
MAKE A SKETCH FROM A PHOTO: CLASSIC STYLE

The Classic style in AKVIS Sketch lets you create color and B&W drawings with well-defined contour lines.

A characteristic feature of this style is its accuracy: the image looks as if it was primarily created by contour lines with the addition of hatching. Though this mode is versatile and good for many purposes, it is the most suitable for technical illustration, architectural images, and other pictures where you would like to attain good detail.

In the Sketch tab you can adjust the parameters for the photo-to-sketch conversion.

There are three parameter fields in the Classic style: Strokes, Edges, and Effects.

Note: You can see the conversion result immediately, as you move the slider, only in the Preview Window. To convert the whole image, press the button or click on the After tab.

Strokes tab (hatching parameters):

Original Colors. When the check-box is enabled, the program imitates a color pencil drawing using the color range from the original image. When the check-box is disabled, the program uses the colors selected with the color plates below (by default black and white).
You can change the saturation of the colors by moving the slider to the right of the check-box. As the value of this parameter is increased, the colors in the image become more intense and bright.

**Pencil Color** and **Background Color.** If the **Original Colors** check-box is disabled, you can use two color plates to set colors for the pencil strokes and background. Click on the plate and select a color from the standard dialog. Right mouse click on the plates resets the colors to their default values (black and white).

**Angle.** The parameter sets the pitch angle of the strokes when hatching a uniform area (an area that does not contain edges and intensity swings). By default the strokes in such areas are drawn at a 45 degree angle. The parameter has values between 0 and 180 degrees; the step is 5 degrees.
**Stroke Thickness.** This parameter sets the stroke size. If you reduce the value, the strokes on the picture get thinner and harder, if you increase the value, the strokes get wider and blurred on their edges.

**Min Length/Max Length.** This parameter sets a range within which the stroke length can vary. There are two sliders to define the range borders: the left slider sets the minimum length, the right slider sets the maximum length. The resulting sketch will be made up of strokes that fall within this range.

If you reduce the minimum length, the number of strokes and the detail of the image increase. Visually the drawing becomes darker. If you increase the value of the minimum length, the number of strokes is reduced (strokes shorter than the set minimum do not get drawn). Visually the image becomes lighter and neater.

If you increase the maximum length, the hatching becomes less uniform. The higher the value of this parameter, the longer strokes can be drawn on the picture. However, if the value is too high it may worsen the precision of the hatching.

**Midtones Intensity.** This parameter defines the intensity of the midtone strokes, as if drawn with different pressure. As you move the slider to the left, the midtone strokes fade - becoming dim and blurred. As you move the slider to the right the midtone strokes become thicker and more intensive.
Midtones Intensity = 1  Midtones Intensity = 10

Midtones Hatching. This parameter changes the level of hatching in the midtone areas. If you want to reduce hatching move the slider to the left.

Midtones Hatching = 1  Midtones Hatching = 100

Edges tab (parameters that affect how edges are drawn):

Edge Strength. This is the main parameter used to control edges, by adjusting the intensity of lines and details. At lower levels there are fewer edges and the level of detail decreases, while at higher values more edges are drawn and more detail is present.

Edge Strength = 0
**Edge Tracing.** This check-box is used to detect the additional edges between areas that don't have well-defined transitions in brightness. Its affect can be adjusted further by these two parameters:

**Sensitivity.** The higher the value of this parameter the more transitions between colors will be retrieved and the more edges will be defined by lines instead of hatching. If you want to emphasize the edges, increase the value of this parameter.
**Edge Width.** This parameter defines the thickness of the outliness. At higher values of this parameter the edges will be drawn by thicker lines.

![Edge Width comparison](image)

**Effects tab:**

**Watercolor (0-50).** The parameter lets you add the watercolor effect to your drawing. By default it is set to 0 which corresponds to a pencil drawing. As you move the slider to the right (that is, increase the value of the parameter) the strokes get blurred, contrast and detail get weaker, as if the strokes were drawn on wet paper. The higher the value of the parameter, the stronger the effect. We recommend to use this parameter together with **Coloration** to get a watercolor drawing.

![Watercolor effect](image)

**Charcoal (0-10).** The parameter changes the drawing technique from a fine pencil drawing to charcoal. The higher the value of the parameter, the more the result looks like a charcoal drawing.
Coloration (0-100). The effect adds color to a drawing provided that the original image contained color information (if the image is not grayscale). By default the value is set to 0. When you increase the value, the drawing is mixed with the original picture.

Smudging (0-30). The parameter creates the effect of smearing hatching in midtone areas without affecting the contour lines of the drawing. This technique looks like a result of rubbing across a drawing with a stump tool, smooth paper, or a finger. By default it is set to 0 at which there is no smudging effect. At higher values the appearance of shaded areas changes. Shading becomes similar to soft graphite. It is a fast and simple way to add a soft and blurred texture to a sketch.
Extra Effects check-box:

Shadows (1-30). The parameter enhances shadows giving your drawing more volume and depth.

Noise (0-100). The parameter adds noise to the image increasing the shading effect.

Contrast (0-100). The parameter increases the difference between highlights and shadows. Using this setting, you can get rid of unnecessary details and make the drawing look "cleaner".
MAKE A SKETCH FROM A PHOTO: ARTISTIC STYLE

The **Artistic style in AKVIS Sketch** is designed to create expressive drawings that look like the handmade work of a real artist.

In this style, it is easy to create both a quick sketch and a girlefully drawn and shaded pencil drawing. The main advantage of this style is the ability to play with hatching and to vary the number of shadings and shadows to get natural tonal transitions. This style requires a good photograph. The best results can be achieved if the original photo was taken in the right light and has good contrast.

![Pencil Sketch from Photograph: Artistic Style in AKVIS Sketch](image)

In the **Sketch** tab you can adjust the parameters for the photo-to-sketch conversion.

The parameters in the **Artistic style** are grouped in three tabs: **Strokes**, **Edges**, and **Effects**.

**Strokes** tab (hatching parameters):

**Original Colors.** When the check-box is enabled, the program creates a color pencil drawing using the color range from the original image. When the check-box is disabled, the program uses the colors selected with the color plates below.
**Color Pencil Drawing**

**Pencil Color** and **Background Color**. If the **Original Colors** check-box is disabled, you can use two color plates to set colors for pencil strokes and background. Click on the plate and select a color from the standard dialog. Right mouse click on the plates resets the colors to their default values (black and white).

**Lightness** (-100 to 100). It is general luminance of the resulted image. The parameter determines how much light or dark strokes the pencil drawing will use.
Lightness = -50
Lightness = 50

**Angle** (0-180). This parameter sets the pitch angle of the strokes. By default the strokes are drawn at a 45 degree angle. The parameter has values between 0 and 180 degrees; the step is 5 degrees.

Angle = 30
Angle = 145

**Dispersion** (0-100). It's a deviation of the hatching direction specified by Angle. The larger the value, the more chaotically strokes will be re-oriented from the general direction.

Dispersion = 10
Dispersion = 90

**Min Length/Max Length** (1-100). The parameter sets the full range of the possible stroke lengths. The stroke length is controlled by the position of two sliders on the same scale: the left slider sets the minimum stroke length while the right slider controls the maximum stroke length. You will see only the strokes greater than the minimum and shorter than the maximum settings.
**Stroke Thickness** (1-50). This parameter sets the stroke size. If you reduce the value of the parameter the strokes on the picture get thinner and harder, if you increase the value the strokes get wider and blurred on their edges.

**Uniformity** (1-100). The parameter defines a type of hatching. In large values the light and dark areas of the image are hatched evenly. Decreasing of the value leads to the selective hatching: the dark areas become more intense and get more strokes, while on the light areas we see less hatching.

**Curvature** (0-100). The parameter changes the strength of the strokes curvature under the influence of gradient areas. The higher the value, the more curve the strokes will be.
Curvature = 10  Curvature = 90

**Hatching Density** (0-200). It defines the number of strokes in the image. The higher the value, the less white areas remain. When the value is set to 0 only contour lines are drawn on the image (see the *Edges* tab).

Hatching Density = 20  Hatching Density = 135

**Hatching Intensity** (0-100). This parameter changes the intensity of the strokes, as if drawn with different pressure and brightness.

Hatching Intensity = 20  Hatching Intensity = 80

**Cross-hatching** check-box (only for Home Deluxe and Business licenses). It activates the special mode of drawing when the pencil strokes are drawn in different directions and intersect.
Parameters of cross-hatching:

**Rotation Angle** (-90 to 90). It defines the angle between the main and additional hatching.

**Frequency** (0-50). It controls the intensity of the additional hatching.

**Edges** tab (parameters that affect how edges are drawn):

**Hint:** We recommend to adjust edges while the hatching is off. To do this, set **Hatching Density** to zero (in the **Strokes** tab).

**Sensitivity** (0-100). The parameter helps to find the edges on the image. The higher the value the more contours will be drawn. To remove odd lines reduce the value of the parameter.
**Detail** (0-200). The parameter changes the number of the strokes forming the contour lines. The size of these strokes is calculated automatically, depending on the value of **Stroke Thickness** (in the **Strokes** tab).

**Intensity** (0-100). It lets you change the brightness of the contour lines.

**Effects** tab:

The parameters on this tab become active by clicking the **Apply effects** check-box.

**Shadows** (1-30). The parameter enhances shadows giving your drawing more volume and depth.
Noise (0-100). The parameter adds noise to the image increasing the shading effect.

Contrast (0-100). The parameter increases the difference between highlights and shadows. Using this setting, you can get rid of unnecessary details and make the drawing look "cleaner".
**TIMELINE**

**AKVIS Sketch** lets you observe the conversion of your photo into a pencil drawing in real time. During the process, the program creates a list of intermediate shots which represent different stages of conversion — from a semi-processed sketch to a practically finished work. Without changing the settings you can create variations of drawings!

The **Timeline** is displayed at the bottom of the main window.

![Timeline in AKVIS Sketch](image)

**Attention:** The **Timeline** feature can only be used by owners of **Home Deluxe** and **Business** licenses. Note that everyone, even with a **Home** license, can get a semi-processed image using the **Stop** button in the progress bar.

Start conversion of your photo into a drawing by pressing the button 🔄. You will see shots appearing at the bottom of the window in the course of processing.

You can also take snapshots of your favorite moments with the button 📸 right of the progress bar. When you press it the drawing in its current state will be added to the list; such manual shots are selected with the blue frame.
If you press the **Stop** button in the progress bar, image processing will be interrupted.

Browse the shots in the **Timeline** to find the image you like most. If you want to get back to your final result, click on the last shot in the list.

When you change the parameters and re-run image processing, the **Timeline** will be cleaned up and will start being filled up with new shots. You can save some of the variants by pinning them with a double click. In the upper corner of the selected shot appears the icon ☐.

You can switch between the shots, change the settings and re-start processing - the pinned result will remain in the list. It's possible to unpin it with a double click.
Attention! Loading a new image into the program removes all shots, including pinned.

Note:
After using the post-processing tools, switching to another image in Timeline will result in the loss of changes made with the tools. You can save the result under a new name and continue working.

You can hide/show the Timeline in the program’s preferences. If the Timeline Shots option is enabled, you can set the number of the shots created during image processing.

![Program's Preferences](image-url)
TOOLS AND THEIR OPTIONS

In AKVIS Sketch, different tools become visible depending on the active tab, Before or After.

The tools in the program are divided into the groups: pre-processing (Before tab), post-processing (After tab), and additional tools (Before and After tabs).

Hint:
You can use the buttons \( \leftarrow \) and \( \rightarrow \) to undo/redo the operations made with the tools: \( \text{undo} \), \( \text{redo} \).

Pre-Processing Tools (on the Before tab):

Quick Preview \( \text{Quick Preview} \). This button switches on/off the preview window, a square frame outlined with the "marching ants" that instantly displays changes made in the Sketch and Decoration tabs.

You can drag the preview square to any position with the left mouse button or with the double click. This lets you quickly preview the effect in different areas of the image. To compare the result of automatic conversion with the original picture, click and keep mouse pressed within the preview area.

You can adjust the preview window size in the program's preferences.
**Stroke Direction**  
The tool gives you full control over the strokes. With this technique you can achieve truly realistic drawings with patterns and textures going in the right direction.

**Note:** This feature is only available for the advanced licenses (Home Deluxe, Business) in the Classic style.

Add the *guiding lines* with this tool, and the program will re-make the drawing following the new direction. The changes will be shown in the preview window. To re-start the image processing, click on the button.

You can adjust the parameters that influence on the effect in a pop-up box that appears when right-clicking in the image:

**Zone of Influence.** The parameter changes the width of the area affected by guiding lines. The higher the value, the more hatching will follow the direction of the lines.

**Preserve Edges** check-box. When this check-box is enabled, the effect does not extend to the outlines.

![Automatic Strokes, Guiding Lines, Changed Direction](image)

**Hint:** You can save guiding lines to a .direction file with the button, and load them with for further processing. Loaded lines automatically adapt to the image size.

**Effect Area**. This tool is only visible if the Sketch & Photo / Sketch & Blur mode is enabled in the Background tab. It lets you select an area to be converted to a drawing.

**No Effect Area**. This tool is only visible if the Sketch & Photo mode is enabled in the Background tab. Use it to select an area that will remain in its original state.

**Blur Area**. This tool is only visible if the Sketch & Blur mode is enabled in the Background tab. Use it to define an area that will be blurred.

**Eraser**. Use this tool to edit the outlines drawn by the pencils.

In the Classic style, when Sketch & Photo / Sketch & Blur is active, the **Eraser** can operate in one of these modes and erase:

- all lines (both guiding lines and zone lines of the background effects);
- only area outlines (background effects);
- only guiding lines (direction of the strokes).

You can also adjust the **Size** of the pencils and eraser in a pop-up box appearing with a right click of the mouse.
Post-Processing Tools (on the After tab, for Deluxe/Business):

Attention! The post-processing tools are only available under the Home Deluxe/Business licenses, on the After tab. Use them at the final step. If you re-run the image processing the changes made with the post-processing tools will be lost!

The tools' options are shown in a pop-up box which appears after right-clicking in the image.

**Pencil** This tool lets you draw lines over the result. The color of the pencil is the same as specified in the Sketch tab.

- **Size** (1-50). The line width which can be drawn with the tool.
- **Hardness** (0-100) defines the blurriness of the tool's edges. The less the value the more blurry the tool's edges become.
- **Opacity** (1-100). The opacity of the strokes drawn with the pencil. The lower the value, the more transparent the lines will be.
- **Smoothing**. The check-box eliminates the irregularity of the line. The strokes drawn with the tool get smoothed out.
- **Refined Lines**. The check-box changes the appearance of the pencil strokes. When this option is enabled, the ends of the lines become thinner, the drawing looks more refined and elegant.

**Eraser** lets you erase the pencil strokes, both generated with the program and drawn manually with the tool, using the background color selected in the Sketch tab.

- **Size** (1-1000). The width of the transparent line which the eraser leaves behind.
- **Hardness** (0-100). The amount of blurriness of the brush's edge. As the value of this parameter increases the edge of the brush becomes harder. Near 100% the border between erased and unerased areas will be more distinct; at lower values the boundary between these areas will be smoother.
**Strength** (1-100). The amount of influence on an image. As this parameter's value is increased, the degree of transparency left by the brush increases.

**History Brush** lets you fade the drawing effect and restore the image to its original state.

The tool's parameters:

- **Restore to Original**. If the check-box is enabled, the tool edits all changes, weakening the drawing effect, as well as the result of the post-processing tools. If the check-box is disabled, the brush changes only strokes drawn with the pencil but does not affect the result of the photo to sketch conversion.

- **Size** (1-1000). The width of a line made by the brush.

- **Hardness** (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool's edges become. At value 100% the border between the brush's edges and the background is very distinct; at lower values the transition between these areas is smoother.

- **Strength** (1-100). The degree of restoration to the original state. At lower values there will be less restoration and more blending with the effect; at value 100% the original image will be restored more completely.
Crop (in the standalone version) lets you cut off unwanted areas in the image. The tool is useful when you want to improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and contrariwise.

You can change the crop area by dragging the sides and the angles of the bounding frame.

To apply the result and remove the areas outside the frame, press OK or use Enter. To cancel the operation and exit the tool, press Cancel or use the Esc-key. To restore the original area keeping the tool active, press Reset button.
Adjust the crop options:

You can choose the size of the crop rectangle from the **Ratio** drop-down list or enter your custom aspect ratio.

If the **External Area** check-box is enabled, you can change the color and opacity of the outer parts.

**Additional Tools** (available on both tabs, for all licenses):

- **Hand** lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click on the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction. The hot-key is **H**.

  Double-clicking on the tool's icon on the Toolbar makes the image fit the window.

- **Zoom** lets you change the image's scale. To zoom in left click on the image. To zoom out left click with **Alt** on the image. The hot-key is **Z**.

  Double-clicking on the tool's icon makes the image scale to 100% (actual size).
BACKGROUND EFFECTS

Use the **Background** tab to process the converted image further. It is possible to imitate a blend of the original photo and the drawing or to blur some parts of the image.

This tab can be used to put an accent on a certain fragment of the image or to enliven a picture by adding motion. For example, it is possible to separate the background from the object (a plane or a bird in the sky; a soft toy on a sofa; a vase with fruit, etc.) or to single out one object among several equivalent objects (one person in a group photo, the most beautiful flower in a garden image, etc.) and many other things.

The **Background** tab offers three modes: **Sketch**, **Sketch & Photo**, **Sketch & Blur**.

**Sketch**

In this mode, the **Background** tab has no influence on the image. In other words, the additional background effects are disabled. It is the default mode in which the first tab's settings, controlling the photo-to-sketch conversion, only work.

To use the other two modes you need to specify areas with the special tools.

**Sketch & Photo**

In this mode, you can get a blend of a drawing and a picture - only the defined parts of the image will be converted into a drawing.
Sketch & Photo Mode

When this mode is enabled, the special tools appear in the **Toolbar**, that will help you to **define, which areas will be converted to a drawing**, and which not.

- **Effect Area**. Use the blue pencil to draw an outline within the areas that will be converted to a drawing in accordance with the parameters of the **Sketch** tab.
- **No Effect Area**. Use the red pencil to outline the parts of the image that will remain in their original state.
- **Eraser**. Use this tool to edit the outlines drawn by the pencils. When **Sketch & Photo** (or **Sketch & Blur**) is active, the tool can operate in three different modes:
  - Erase all lines (both guiding lines and zone lines of the background effects);
  - Erase only guiding lines (direction of the strokes);
  - Erase only zone lines (background effects).

Adjust the **Size** of the tools in a pop-up box that appears when right-clicking in the image.

**Note:** If only blue lines or no outlines are drawn, the entire image will be a drawing. If only red lines are
used, the image will be restored to its original state.

**Attention!** During processing you will see that the whole image (regardless of the drawn lines) will be converting into a drawing. Don't worry. It's only one of the processing steps, not an error. In the next step the program will take into consideration the background effects lines and settings.

**Grayscale.** This option works only for black and white drawings. When the check-box is enabled, the areas marked with red (or green, in the 3rd mode) are converted to grayscale. Use this option to get the entire image in black and white, not only the "drawing" part.

Grayscale is disabled: Original Image  
Grayscale is enabled: B&W Image

**Sketch & Blur**

In this mode, it is possible to blur the selected parts of the image. In the **Toolbar** you will find these tools: **Effect Area**, **Eraser**, and the **Blur Area**. The latter is used to define the areas that must be blurred.

Select a **Blur Method** that will be used in image processing and adjust the parameters.

- **Gaussian Blur.** When this method is selected, the program recalculates the color components (red, blue, and green) for every point of the image, taking into account the corresponding values of the neighbouring points; as a result the points change their colors. The calculation is based on the Gaussian distribution and is named after it. In this way the values of the color components are averaged and the contrast between them weakens. The sharp borders are blurred without general lightening or darkening. The image gets dim, "cloudy".

Gaussian Blur
The **Radius** parameter adjusts the strength of the effect application. It defines to what extent a point influences on the neighbouring points when its color components are being recalculated. At low values only the adjacent points will be changed. Every point will undergo a slight change, but the blurring will be visible. The higher the value of the parameter, the wider is the influence area of every point. The image will get more blurred till it becomes completely indiscernible and looks like one stain (at high values of the parameter).

- **Motion Blur.** This blur method imitates the straight line motion of a camera.

Parameters:

**Angle.** This parameter sets the inclination angle of the line, along which the effect will expand to the image. The values of the parameter vary between 0 and 180 degrees. At exactly these values the blurring will be horizontal. At value = 90 the blurring will be vertical.
Reach. This parameter defines the zone of effect application in pixels (relative to every point of the image).

- **Radial Blur.** This method imitates motion, too. There are two kinds of motion:
  
  **Spin.** This mode imitates the effect of a camera rotating around the central point of the image, which results in circular blurring.
**Zoom.** This mode creates blurring directed away from the center.

The rotation angle in **Spin** mode and the effect application area in **Zoom** mode are adjusted with the **Amount** parameter.

In the **Sketch & Blur** mode, you can also choose one of the following methods of the result image generation - **Blur Order**: 
**Drawing on Blur.** In this case the blue areas are converted to a drawing, while the green areas are first blurred with the settings of the selected **Blur Method**, and only than are converted to a drawing in accordance with the settings of the **Sketch** tab.

![Blurred and Drawn Images](image)

**Blur Photo.** In this mode the blue areas are converted to a drawing, while the green areas are only blurred, not converted. The result image is a blend of the blurred photo and the sketch.

![Blurred Images](image)
In this mode the **Grayscale** check-box can be applied.

**Blur Sketch.** In this mode the whole image is transformed into a drawing, but the green areas are also blurred.
ADD A FRAME TO A PENCIL DRAWING

In **AKVIS Sketch** you can also add a frame to your sketch drawing to create a real work of art.

In the **Decoration** group switch to the **Frame** tab, enable the check-box of the same title, and choose the frame style and texture.

**Hint:** You can drag the **Canvas/Frame/Text** tabs to change the order of the application of the decoration effects.

You can apply these frames to your sketch:

- **Classic Frame**
- **Pattern Frame**
- **Strokes**
- **Vignette**
- **Passe-Partout**
ADD TEXT OR WATERMARK TO YOUR DRAWING

You can personalize your work of art by adding a signature to your pencil drawing, create a postcard by placing greeting text, insert a logo or a watermark to your image to protect it.

Select Decoration -> Text tab. By default, the parameters of the tab are disabled; for the inscription to appear on the image, enable one of the modes - either Text or Image.

**Hint:** You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

You can add any text or image.

Adjust the text/watermark settings.
**IMITATE SKETCH DRAWING ON A CANVAS**

**AKVIS Sketch** not only offers photo-to-sketch conversion, it also lets you add a textured surface to a picture imitating a drawing on a canvas, corrugated paper, brick wall or anything else.

To use this effect, adjust the settings in the **Decoration** group in the **Canvas** tab.

By default the parameters of the tab are disabled and the sketch comes out as if drawn on plain paper. To activate the parameters of the **Canvas** tab, select the check-box **Use Canvas**.

**Hint:** You can drag the **Canvas/Frame/Text** tabs to change the order of the application of the decoration effects.

You can choose a texture from **Library -> Surface** or load your own sample: **Library -> Custom...**

**Adjust the canvas settings.**
**WORKING WITH PRESETS**

**AKVIS Sketch** includes ready to use presets. When moving a cursor over an AKVIS preset in the drop-down list, the sample appears in the small window on the left side of the list. You can modify the settings of the preset to achieve the desired result.

The program lets you create your own presets by saving your favorite combinations of the parameters. Enter a name for your preset into the field and press the **Save** button. The next time you start the program the last settings will be used by default.

To return to the initial settings of the selected preset, click on **Reset**.

To delete a preset, choose it from the drop-down list and press **Delete**. The AKVIS presets cannot be removed.

The AKVIS built-in presets cannot be removed.

To convert a photo into a drawing using a preset, choose it from the list and press ![Play](image)

You can save your presets to a **.sketch** file with ![Save](image). To load presets from the file use ![Load](image).

**Note:** You should import and export presets for each style separately.
The button opens the Preferences dialog box. It looks like this:

- **Language.** Change the program language by selecting another from the drop-down list.
- **Interface Scale.** Choose the size of the interface elements. When it is set to Auto, the program workspace will automatically scale to fit the screen resolution.
- **Interface Theme.** Select the style of the program interface: Light, Gray, or Dark.
- **Preview Window Size.** Choose the desired value for the size of the Preview Window. It can have values from 200x200 to 1000x1000 pixels. By default the parameter’s value = 500, that is the quick preview area has a proportion 500x500 px.
- **Processing Size Limit.** This parameter accelerates image processing by temporary reducing the size of the image to be processed. When the file size (in megapixels) does not exceed the defined value, the image is processed in a usual way. If the loaded file is larger, the program will reduce the image, process it and enlarge again to the initial size.
- **Initial Image Scale.** This parameter defines the way the image is scaled in the Image Window after opening. The parameter can take one of two values:
  - image scaling **Fit to View.** The scale adjusts so that the image will be completely visible in the Image Window;
  - if the option 100% is checked, image doesn't scale. Generally, when the scale = 100%, only part of the image will be visible.
- **Timeline Shots.** This parameter changes the number of the shots created during image processing (available only for Home Deluxe and Business licenses).
- **Hints Panel.** When you hover over parameters and buttons with the cursor you can see a brief description of them in the Hints field. You can choose how the hints will be shown:
  - **Under Image Window.** It shows the hints in the main window, under the image. This mode is useful if there is not enough space by height to display this field under the settings;
  - **Under Settings Panel.** Select this to show hints at the bottom of the right part, under the settings;
  - **Hide.** Use this option if you do not need the hints.
- **Recent Files** (available only in the standalone version). The number of recent documents. The list of the recent files, sorted by time, become visible by right mouse clicking on . Maximum: 30 files.
- **Use OS File Dialog** check-box. You can check this option if you want to use the System Open/Save Dialog. By default, the AKVIS File Dialog is used.
- **Lock the Control Panel** check-box. It disables the possibility to hide/show the top panel.
check-box is enabled the panel is always visible. Uncheck the option to unlock the panel, and you will be able to hide/show it by clicking on the small triangle button (in the middle of the panel). The minimized panel will be shown when moving the cursor over it.

To save changes made in the Preferences window press OK.

If you need, click on the button Default to come back the default settings.
**BATCH PROCESSING**

**AKVIS Sketch** supports **batch processing** that lets you automatically process a series of images.

Batch processing is useful when dealing with a lot of photos taken under the same conditions with identical camera settings or when creating a video (to process all frames automatically). It saves you time and effort.

If you use the standalone version of **AKVIS Sketch**, read the instructions here.

If you use the **Sketch** plugin in Photoshop, use this tutorial.
BATCH PROCESSING WITH PHOTOSHOP PLUGIN

The AKVIS plugins support the automation feature in Adobe Photoshop.

Batch processing is very useful and time saving when you have to apply the effects to a number of photos. This method applies the same settings to a folder full of images.

Even if you have never used batch processing you will find no difficulties in understanding it. First you create an Action in Photoshop and then apply it to a photo folder.

Follow the instructions:

**Step 1.** Create two new folders, for example: "source-files" and "result-files". Place original images into the "source-files" folder. The results will be saved in the "result-files" folder.

**Step 2.** Open one of the original images in Adobe Photoshop. We will use this photo to adjust the plugin's settings and create an action.

**Step 3.** In the Actions palette click Create New Set button. In the dialog window give a name for a new set of actions, for example, "AKVIS Actions".

If you already have a special set for the AKVIS actions, you can just choose it.

**Step 4.** Press Create New Action and give a name for it, for example, "Neon".
Press the **Record** button, and the recording of the action will immediately start.

**Step 5.** Call the plugin and adjust its parameters.
Step 6. Press the button ✓. The plug-in window will close and the effect will be applied to the image. In the Actions palette, in your new action, you will see a new line with the plugin's name.

Step 7. Remember that the action is still being recorded. Now, you should save the image. Choose Save As in the File menu and save the image into the destination folder.

Step 8. Stop the action recording by pressing Stop playing/recording at the bottom of the Actions palette.

Step 9. Delete the file that you have just saved.

Step 10. The action is created and you can proceed to batch processing of the photos.

In the File menu of the editor choose Automate -> Batch.
Step 11. In the Batch dialog window and set the parameters:
In the Set drop-down list choose "AKVIS Actions" and the new action.
In the Source option set Folder. Press the Choose... button and select "source-files". As the Open command was not recorded in the action, the Override Action "Open" Commands check-box should be deactivated.
For Destination select Folder, then press the Choose... button and select "result-files". Activate Override Action "Save as" Commands check-box.
In the File Naming section you can create the filenames structure for the resulted images. If you do not want to change the names, in the first combo-box choose document name, and in the second - extension.

Step 12. Press OK to start processing. Photoshop will apply the AKVIS plugin to all photos in the "source-files" folder, one by one, and will save them to the "result-files" folder.
PRINT IMAGES IN AKVIS SKETCH

In the standalone version of **AKVIS Sketch** you can print the image.
Press the button (¶) to open the **Print** options.

![Print Options in AKVIS Sketch](image)

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the **Orientation** group, set the position of paper: **Portrait** (vertically) or **Landscape** (horizontally).

Click the **Page Setup** button to open a dialog box to choose the size of the paper and its orientation, as well as the print margins.

Press the **Reset Margins** button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters **Scale**, **Width**, **Height** and **Fit to Page**. These parameters have no effect on the image itself, just on the print version. You can change the size of the printed image by entering any value in %, or by entering new values in **Width** and **Height**.

To adjust the size of the image to the paper size, select **Fit to Page**.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate **Frame** for the image and adjust its width and color.
Choose the **Background Color** by clicking on the color plate.

In the **Page** tab, you can adjust printing of the multiple copies of the image on a single sheet.

- **Copies per Page.** It lets you specify the number of copies of the image on one page.
- **Horizontally and Vertically.** These parameters indicate the number of rows and columns for the copies of the image on the page.
- **Spacing.** The parameter sets the margins between the copies of the image.

In the **Poster** tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a large picture.

- **Pages.** If the check-box is enabled, you can specify the maximum number of the pages in which the image will be divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the program will automatically select the optimal number of the pages in accordance with the actual size of the image (scale = 100%).
- **Glue Margins.** If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins will be added to the right and to the bottom of each part.
- **Lines of Cut.** Activate the check-box to display the cut marks in the margins.
- **Show Numbers.** With the enabled check-box, a sequence number of each part, by a column
and a row, will be printed in the margins.

To print the image with the chosen parameters, press the **Print** button. To cancel and close the printing options click on **Cancel**.

Click the **Properties...** button to open a system dialog box that enables you to access the advanced settings and send the document to print.
SHINY APPLE: AN ARTIST'S TOUCH

When creating a high-quality drawing, it is necessary not only to pay attention to lines and details, but also to how textures are represented. The Stroke Direction tool and other features of AKVIS Sketch can convey the structure of an object as if it were drawn by a real artist.

Step 1. Open the image in the graphics editor with the menu command File -> Open.

Step 2. Call the plugin Filter -> AKVIS -> Sketch. In the preview window you can see how a part of the photo would be processed with the AKVIS Default preset. To process the entire image press the button.
Step 3. Adjust the settings to make strokes clearer and more expressive:

- **Charcoal** = 2;
- **Min Length/Max Length** = 5/13;
- **Midtones Intensity** = 6.

Process the image again:

Step 4. The uniform strokes across the image do not look very realistic. To make the strokes follow the contours of the object, activate the tool and draw a few guiding lines. Change the parameter **Zone of Influence** to 76, so that more strokes will follow the guiding lines.
Press the \[ \text{button} \]. The result differs from the one received in Step 3:

**Step 5.** Note that small defects were formed over the smooth surface of the apple where there were spots.
It’s possible to make these defects less noticeable using the features of the program.

**The first method:** deactivate the **Preserve Edges** check-box. The strokes reorient themselves in a general direction, but now the image’s borders are weaker.

![After "Preserve Edges" Was Deactivated](image)

**The second method:** use the blur tools. Usually these are used to create an effect, but here they can be used to correct a defect.

Switch to the **Background** tab and choose **Sketch & Blur** from the drop-down menu, the processing method **Drawing on Blur**, and the **Gaussian** blurring method.

Use the blue pencil (Effect Area Tool) to indicate the area that will not be blurred. Use the green pencil (Blur Area Tool) to mark the area with defects - they will be blurred before the photo is converted into a drawing.
Start processing by pressing the button.  

**Step 6.** Press the button, to apply the changes to the image. The plugin's window closes, and the processed image will appear in the graphics editor.

Finally, the image needs to be brighter. To do this, make a copy of the image by choosing **Layer -> Duplicate Layer**. Apply the **Linear Burn** blend mode to the top layer in the **Layers** palette, set the **Opacity** to 30% and choose the command **Layer -> Flatten Image**.
SELF-EXPRESSION: SKETCH IN A MINUTE

The author of this tutorial is Valentina Aynagos.

Often on the street, in a cafe, or at a train station one will often see people with a distinctive style. Sometimes a special style of dress is not simply a fad, but an expression of individuality or a sign of belonging to a particular subculture. Nevertheless, imagination can not only be shown through appearance, but also through creativity. In the following tutorial a photo of anime girls was transformed into an original color drawing in less than a minute. All that is needed is a little imagination and AKVIS Sketch.

Step 1. Open the photo in AKVIS Sketch. Soon afterward the Preview Window will display the result based on the program's default settings (AKVIS Default Preset).

Step 2. Leave the preset’s settings unchanged and click on the check box next to Original Colors in the Settings Panel. Press the button to process the image.
Step 3. To use a Gaussian Blur effect, click on the Background tab, choose Sketch & Blur mode from the drop-down menu, and the Drawing on Blur processing method.

Use the blue pencil (Effect Area Tool) to mark areas in the image that will remain unchanged. Use the green pencil (Blur Area Tool) to indicate the area to be blurred.

Step 4. Process the image again by pressing the button. The sketch begins to be revealed. Processing can be stopped at any time by pressing on the button right to the Progress bar - this will prevent undesired details from being added to the image.
**Step 5.** Press the **button and save the result.**

*Result: Anime Girls*
CONVERT A PHOTO TO A COLOR SKETCH

By default **AKVIS Sketch** converts any image into a black and white pencil sketch. But if the original photo is colored, it is possible to add color from the original image to the pencil drawing.

![Source image: photo of a hotel](source_image.png) ![Result: color sketch](result_sketch.png)

We use the Sketch plugin in this tutorial, but you can take the standalone edition and use the same parameters to achieve this result.

**Step 1.** Open a color photo in your photo editor.

**Step 2.** Call the plug-in **AKVIS Sketch**. For this purpose in **Adobe Photoshop** select the menu item **Filter – AKVIS – Sketch**; in **Paint Shop Pro Photo** select the menu item **Effects – Plugins – AKVIS – Sketch**; in **Corel Photo-Paint** - the menu item **Effects – AKVIS – Sketch**.

**Step 3.** Press the button ![ AKVIS Sketch ](button.png) to convert the photo into a pencil sketch with the default settings.
Step 4. Reduce the value of the parameter **Stroke Thickness** to make the lines thinner and harder.

Reduce the value of the parameter **Midtones Intensity** to reduce the intensity of hatching in the uniform light areas of the picture (i.e. the sky).
Step 5. Let's add color to our pencil drawing by increasing the value of the parameter **Coloration** to 70.

Also you can use the **Color Pencil** option in the **Strokes** section. The result will differ, the option imitates color strokes.

It's possible to use both ways to add color to pencil drawing (**Coloration** and **Color Pencil**).

**Step 6.** Press the button ✅ to apply the result to the image and close the program.
PENCIL SKETCH FROM PHOTO: A TULIP DRAWING

For the first illustration of how *AKVIS Sketch* works we have chosen a simple picture: a flower in the foreground and a blurred background without any clear details.

![Source photo of a tulip](image1.jpg) ![Black and white pencil drawing](image2.jpg)

We use the Sketch plugin in this tutorial, but you can take the standalone edition and use the same parameters to achieve this result.

**Step 1.** Open the image with your photo editor and call the plug-in *AKVIS Sketch*. Press the button ![button](image3.png) to process the photo with the default settings. The image will turn into a pencil sketch.

**Step 2.** Reduce the value of the parameter *Stroke Thickness* to make the strokes thinner and harder.

As you change the value of a parameter press the button ![button](image4.png) to process the photo with the new settings and see what influence the adjusted parameter has on the drawing.
**Step 3.** The parameter *Angle* sets the pitch angle of the strokes when hatching a uniform area. On this picture the background is uniform and we can notice that the strokes are drawn 45 degree to the right. Let's change the pitch angle in such a way that the strokes in the background had the same angle as the tulip. We set the parameter *Angle* to 135.

**Step 4.** Now reduce the value of the parameter *Midtones Intensity* to 1 to make the background less bright.

Here is our black and white pencil drawing:
Step 5. Press the button to apply the conversion result to the image and close the program.
AKVIS PROGRAMS

AKVIS Sketch Video—Convert Video to Cartoon
(Windows | Mac)
AKVIS Sketch Video is an After Effects and Premiere Pro plugin for converting videos into animated cartoons, both black and white and color. Apply cartoon effects easily with the Sketch Video plugin! More...

AKVIS AirBrush — Airbrushing Techniques on Your Photos
(Windows | Mac)
AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen settings of photo-to-painting conversion. More...

AKVIS ArtSuite — Frames and Effects for Your Photos
(Windows | Mac)
AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and texture samples that can be used to create a virtually limitless variety of options for generating frames. Decorate a photo to give it an original and festive look! More...
AKVIS ArtWork — Collection of Painting & Drawing Techniques

(Windows | Mac)

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil Painting, Watercolor, Gouache, Comics, Pen & Ink, Linocut, Pastel. ArtWork helps you to create a piece of art out of any picture! More...
AKVIS Chameleon — Photo Collage Creation
(Windows | Mac)

**AKVIS Chameleon** is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is very easy to handle as it does not require precise selection of objects. Using the software you can quickly create your own photo collages. *More...*

AKVIS Charcoal — Charcoal & Chalk Drawings
(Windows | Mac)

**AKVIS Charcoal** is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding artistic effects, such as sanguine and others. *More...*

AKVIS Coloriage — Add Color to Black and White Photos
(Windows | Mac)

**AKVIS Coloriage** allows colorizing B&W photos and replacing colors in color photos. Just indicate the desired colors by the stroke of the brush; the program does the rest of the work: recognizes the object's border and tailors the new color to the grayscale tones of the initial picture. *More...*
AKVIS Decorator — Resurface and Recolor
(Windows | Mac)

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently. Recoloring is also made easy. More...

AKVIS Draw — Hand-made Pencil Drawing Effect
(Windows | Mac)

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations, produces both B&W and color drawings. Add a hand-drawn look to your pictures! More...
**AKVIS Enhancer — Bring Detail To Your Pictures**

(Windows | Mac)

**AKVIS Enhancer** is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you improve color and adjust tones. More...

![Image Comparison](image-url)

**AKVIS Frames — Decorate Your Photos with Frames**

(Windows | Mac)

**AKVIS Frames** is free software designed for working with the **AKVIS frame packs**

![Frame Examples](image-url)

**AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!**

(Windows | Mac)

**AKVIS HDRFactory** lets you create a High Dynamic Range image from a series of shots or from one single photo. The program can also be used for photo correction. The program brings life and color to your photos! More...

![HDR Example](image-url)
AKVIS LightShop — Light and Star Effects
(Windows | Mac)

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your pictures! More...

AKVIS Magnifier — Change Image Size without Quality Loss
(Windows | Mac)

AKVIS Magnifier helps to resize images without loss in quality. Whether creating poster-size images, adding resolution for printing an enlargement, or reducing image size, Magnifier will make your prints look sharper and better defined. More...
AKVIS MakeUp — Retouch Your Portrait Photos!
(Windows | Mac)
AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look your best in every photo with AKVIS MakeUp! More...

AKVIS NatureArt — Bring Nature to Your Photos
(Windows | Mac)
AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program includes a number of effects: Rain
**AKVIS Neon — Glowing Drawings from Photos**

(Windows | Mac)

**AKVIS Neon** lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like drawn with luminescent ink. [More...](#)

---

**AKVIS Noise Buster — Digital Noise Reduction**

(Windows | Mac)

**AKVIS Noise Buster** is software for noise suppression on digital and scanned images. Digital noise can be
seen as artifacts and random red and blue pixels that compromise the smoothness of a photo. The program is efficient against both color and luminance noise. More...

AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a painter! More...

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More...
AKVIS Points — Apply Pointillism Effect to Your Photos
(Windows | Mac)

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism. With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors! More...

AKVIS Refocus — Focus Improvement & Blur Effects
(Windows | Mac)

AKVIS Refocus improves sharpness of out of focus images. The program can process the entire photo or bring into focus only the selected part to make the subject stand out against the background. It’s also possible to add bokeh and lens blur effects to your photos. The software works in five modes: Refocus, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More...
**AKVIS Retoucher — Image Restoration Software**

(Windows | Mac)

*AKVIS Retoucher* is an efficient program for photo restoration and photo retouching. The software removes dust, scratches, stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the information of the surrounding areas. [More...](#)

**AKVIS Sketch — Convert a Photo to a Pencil Sketch**

(Windows | Mac)

*AKVIS Sketch* converts digital photos to amazing pencil sketches and watercolor drawings. Now you do not need to handle a pencil to feel like an artist. All you need to create your original work of art is good taste and *AKVIS Sketch*. [More...](#)
**AKVIS SmartMask — Save Time on Complex Selections!**
(Windows | Mac)

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The software considerably increases your productivity. You will be freed from boring work and will have more room for creativity and realization of your ideas. [More...](#)

**AKVIS Watercolor — Aquarelle Art from Photos**
(Windows | Mac)

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns ordinary images into amazingly realistic aquarelle pieces of art. [More...](#)